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Introduction
Thank you for choosing the Lattice Semiconductor MachXO™ Control Development Kit! 

This guide describes how to start using the MachXO Control Development Kit, an easy-to-use platform for rapidly 
prototyping system control designs using MachXO PLDs. Along with the evaluation board and accessories, this kit 
includes a pre-loaded control system-on-chip (Control SoC) design that demonstrates board diagnostic functions 
including fan speed control based on temperature monitoring, LCD control, complete power supply monitoring and 
reset distribution in conjunction with the Power Manager II ispPAC®-POWR1014A and 8-bit LatticeMico8™ micro-
controller.

Note: Static electricity can severely shorten the lifespan of electronic components. See the MachXO Control Devel-
opment Kit QuickSTART Guide for handling and storage tips.

Features
The MachXO Control Development Kit includes:

• MachXO Control Evaluation Board – The MachXO Control Evaluation Board features the following on-board 
components and circuits:

– MachXO LCMXO2280C-4FT256C PLD (www.latticesemi.com/products/cpldspld/machxo)
– Power Manager II ispPAC-POWR1014A mixed-signal PLD (www.latticesemi.com/products/powermanager) 
– 2 Mbit SPI Flash memory
– 1 Mbit SRAM

• Interface to 16 x 2 LCD Panel*
– Secure Digital (SD) and CompactFlash memory card sockets*
– I2C temperature sensor
– Current and voltage sensor circuits
– Voltage ramp circuits
– Fan and controller circuitry 
– USB connector (JTAG, RS-232)
– GPIO expansion header landings
– 3” x 1”, 140-hole prototyping area
– Push-buttons for sleep mode and global set/reset
– 8-bit DIP switch 
– PWM analog output circuit
– 8 status LEDs

• Pre-loaded Reference Designs and Demo – The kit includes a pre-loaded demo design (Control SoC) that 
integrates several Lattice reference designs including: the LatticeMico8 microcontroller, PWM fan controller, LCD 
controller, SRAM controller, I2C controller, SPI Flash memory controller, and a UART peripheral. Firmware sup-
ports a temperature, current, and voltage monitoring demo and when connected to a host PC allows you to use 
a terminal program to interact with the MachXO Control Evaluation Board.

• USB connector Cable – A mini B USB port provides a communication and debug port via a USB-to-RS-232 
physical channel and programming interface to the MachXO JTAG port. 

• AC Adapter (international plugs)

• Quick Start Guide – Provides information on connecting the MachXO Control Evaluation Board, installing Win-
dows hardware drivers, and running the Control SoC demo.

• MachXO Control Development Kit Web Page – www.latticesemi.com/machxo-control-kit provides access to 
the latest documentation, demo designs, and drivers for the kit.

* Note: LCD panel, SD and Compact Flash memory not included in the MachXO Control Development Kit.

http://www.latticesemi.com/products/cpldspld/machxo/
http://www.latticesemi.com/products/powermanager/index.cfm
www.latticesemi.com/machxo-control-kit
www.latticesemi.com/machxo-control-kit
www.latticesemi.com/machxo-control-kit
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The contents of this user’s guide include demo operation, top-level functional descriptions of the various portions of 
the evaluation board, descriptions of the on-board connectors, switches and a complete set of schematics of the 
MachXO Control Evaluation Board.

Figure 1. MachXO Control Evaluation Board, Top Side

Lattice Semiconductor Devices
MachXO Device
This board features a MachXO PLD with a 3.3V core supply. It can accommodate all pin-compatible MachXO 
devices in the 256-ball ftBGA (17x17 mm) package. A complete description of this device can be found in the 
MachXO Family Handbook.

Note: The connections referenced in this document refer to the LCMXO2280C-4F256C device. Available I/Os and 
associated sysI/O™ banks may differ for other densities within this device family. However, only the LCMXO2280C-
4F256C device offers full functional use of the entire evaluation board.

Power Manager II Device
This board features a Power Manager II mixed-signal PLD. It serves as general-purpose power-supply monitor, 
reset generator, sequence controller, and high-voltage FET drivers. More information about Lattice Power Manage-
ment devices can be found on the Lattice website. 

http://www.latticesemi.com/lit/docs/handbooks/HB1002.pdf
http://www.latticesemi.com/products/powermanager/index.cfm
http://www.latticesemi.com/products/powermanager/index.cfm
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Software Requirements
You should install the following software before you begin developing designs for the evaluation board:

• ispLEVER Starter or ispLEVER/Pro 7.2 

• ispVM System 17.5

Demonstration Designs
Lattice provides four demos to illustrate key applications of the MachXO (XO2280) and Power Manager II 
(POWR1014A) devices in the context of control applications.

• Control SoC – The Control System-on-Chip (SoC) demo illustrates the use of the LatticeMico8 (LM8) microcon-
troller, peripherals, and firmware integrated to provide system control features such as power supply sequencing, 
temperature monitoring, and fan control. The Control SoC design is the default, pre-programmed demo of the 
MachXO Control Evaluation Board.

• Voltage Monitoring Using Delta-Sigma ADC – Monitor sensors and power rails for free by replacing discrete 
ADCs in your system. This demo implemements a Delta-Sigma Analog-to-Digital Conversion (ADC) technique to 
monitor an analog voltage and convert it into a digital value with the XO2280.

• Memory-Audio – CompactFlash memory is commonly found in system control designs to provide simple plug 
memory. This demo showcases the LatticeMico8 microcontroller, CompactFlash memory controller, and a PWM-
based digital-to-analog conversion to drive the audio jack of the MachXO Control Evaluation Board. A Hyperter-
minal interface allows you to load a wave format file onto the board and play it back using the audio jack output.

• Power Supply Fault Logging – Maximize system reliability by monitoring devices for marginal power supply fail-
ures. This demo continuously monitors the supply rails of the MachXO Control Evaluation Board. If a power sup-
ply failure occurs, the POWR1014A and XO2280 systems will issue a diagnostic log to the on-board SPI memory 
that includes supply identity and level.

Note: You may obtain your MachXO Control Evaluation Board after it has been reprogrammed. To restore the fac-
tory default demo or program it with other Lattice-supplied examples see the Download Demo Designs and Pro-
gramming Demo Designs with ispVM sections of this document.

Control SoC Demo
This demo illustrates how the MachXO and Power Manager II devices can be used to address a variety of system 
control design issues including: 

• Power supply sequencing

• Reset distribution

• Power supply monitoring

• Temperature monitoring and fan control

Power management is handled in two phases by the MachXO Control Evaluation Board system:

1. Power On – After power is supplied to the board and the 3.3V rail is stable, the Power Manager II POWR1014A 
sequences four supply rails. Two circuits demonstrate the voltage ramp of 2N7002E power MOSFETs using 
the high-voltage (HVOUT) outputs and two demonstrate power rail enable of Vcccore and Vccaux of the 
MachXO2280 using digital outputs. Next the POWR1014A asserts the MachXO reset. Finally the POWR1014A 
enters a supply monitoring state.

2. Post Power On – During the second phase of power management the board’s “condition” is monitored. Power 
supply rail voltage, current, and board temperature is monitored by the MachXO2280 and POWR1014A. If any 
supply rail fails, the POWR1014A asserts a reset for the LCMXO2280.

http://www.latticesemi.com/products/designsoftware/isplever/ispleverstarter/
http://www.latticesemi.com/products/designsoftware/ispvmsystem/
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Figure 2. PC Board Control and Power Management
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The MachXO LCMXO2280C is a general purpose 2280-LUT PLD programmed with a small System-on-Chip 
design based on the LatticeMico8 8-bit microcontroller. The LatticeMico8 platform provides board management 
functions for temperature sensing, fan and LCD control, and monitoring of the Power Manager II POWR1014A I2C 
interface. The system is designed to continuously monitor the condition of the board. You can interact with the plat-
form through a menu-driven terminal program running on a PC host. Switches and jumpers can be adjusted to 
emulate reset, Sleep, and supply interruptions.

The LatticeMico8 platform integrates Lattice reference designs for SRAM and SPI Flash memory control, pulse-
width modulation (PWM) fan control, LCD control, and a Power Manager II POWR1014A communication interface. 
All peripherals communicate across a WISHBONE-compatible bus. LatticeMico8 firmware written in Assembly lan-
guage manages communication between peripherals and provides a menu-driven user interface layer for a termi-
nal program running on a host PC. 

The Power Manager II POWR1014A is a 10-input, 14-output, mixed-signal PLD with integrated analog voltage 
comparators, timer/counter circuits, and a PLD core. The POWR1014A is programmed to cover supply sequenc-
ing, reset distribution, and voltage supervision functions. The POWR1014A will trap supply faults and assert 
MachXO2280 reset when appropriate. It disables MachXO2280 supplies input supplies are not stable. An I2C slave 
interface to the POWR1014A allows the MachXO2280 to extract status and read/write control registers for the 
board status.

Board Monitoring and Fan Control
The MachXO2280 design performs monitoring functions for the on-board temperature sensor and supply status 
issued by the POWR1014A device. A rolling board status log is maintained in the on-board SRAM. The on-board 
DC fan motor is activated whenever the programmed temperature threshold is exceeded. 

The MachXO2280 design provides the following features:

• Menu-driven user interface for Windows or Linux PC-based terminal program via USB-to-Serial channel.
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• Board “uptime” clock

• Programmable temperature threshold via the PC terminal program.

• Programmable LCD (not included) backlight and contrast via the PC terminal program.

• Programmable 0-5V ADC input voltage via the PC terminal program.

• Issues a periodic log of time, temperature, voltage level, and fan speed readings to on-board SRAM memory.

• Enables on-board fan during over-temperature conditions. 

Power Supply Sequencing and Reset Distribution
The POWR1014A design shows the Power Manager II in the PC board management role to sequence multiple 
power supplies, distribute reset signals, and monitor power supply voltage/current levels. The POWR1014A’s 
embedded I2C slave interface provides a variety of status registers for basic status polling while the board is opera-
tional. 

The state diagram in Figure 3 illustrates the control logic embedded in the POWR1014A. The following states 
define the control logic:

• RESET – After the MachXO Control Evaluation Board is powered and power-on reset occurs the POWR1014A 
waits until its own supply rail is stable (Power OK). 

• SEQUENCE SUPPLIES – After power is applied to the board and the 3.3V and Vccio supply rails are stable the 
POWR1014A will sequence the MachXO2280 supply rails: Vcccore and Vccaux using two transistor switches. In 
addition two voltage ramp circuits are provided on-board to demonstrate safe operating area (SOA) operation of 
two 2N7002E PNP-type power MOSFETs. LEDs D5-D6 of the POWER1014A LED bank are binary encoded to 
represent the four supply sequence. The minimum value for each VMON input can be set independently by mod-
ifying the PAC-Designer® software project. 

• DISTRIBUTE RESETS – After all supplies are powered the POWR1014A will release three reset signals. Reset 
control of multiple microprocessor/DSP reset circuits is emulated by displaying the Reset state on the 
POWR1014A LED bank. When lit, LEDs D7-D8 represent the reset release state.

• MONITOR SUPPLIES – After the power-on phase (supply sequencing and reset distribution) the MachXO Con-
trol Evaluation Board is operational and a LatticeMico8 8-bit microcontroller based design runs its firmware the 
MachXO2280. The POWR1014A then continuously monitors all input supplies. In this state the MachXO2280 
polls the POWR1014A I2C registers for the evaluation board’s status and makes voltage and current measure-
ments available to the PC terminal interface. 

Figure 3. Power Manager II POWR1014A Embedded Logic
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Download Windows Hardware Drivers
Before you begin, you will need to obtain the necessary hardware drivers for Windows from the Lattice web site. 

1. Browse to the www.latticesemi.com/machxo-control-kit and locate the hardware device drivers for the USB 
interface.

2. Download the ZIP file to your system and unzip it to a location on your PC.

Linux Support:

The USB interface drivers for the evaluation board are included in Linux kernel 2.4.20 or greater including distribu-
tions compatible with ispLEVER® 7.2 (Red Hat Enterprise v3, v4 or Novell SUSE Enterprise V10).

Download and Program the Demo Designs
The Control SoC Demo is preprogrammed into the MachXO Control Evaluation Board, however over time it is likely 
that your board will be modified.

To download the demo source files and reprogram the MachXO Control Evaluation Board:

1. See the Download Demo Designs and Programming Demo Designs with ispVM sections of this document.

2. Use .\Demo_MachXO_Control_SoC\project\control_soc_demo.jed to restore the MachXO2280 Control 
SoC demo design.

3. Use .\Demo_PM_Control_BM\project\bm_demo.jed to restore the POWR1014A Board Management demo 
design.

www.latticesemi.com/machxo-control-kit
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Connect to the MachXO Control Evaluation Board
In this step, power the board, and connect the evaluation board to your PC using the USB cable provided. 

J15

J18

J19

J5

J9

J14

TMS TDIO

XO

PM

XX

Install to
Include Device

Install to
Exclude Device

Notes:
1. Install exactly one device per row to include or exclude each device.
2. Shown with MachXO and POWR1014A enabled. 
 

 

1. Adjust the following jumpers to include the MachXO2280 and POWR1014A devices in the JTAG programming 
chain and exclude the “Other JTAG” option.

Install Jumpers
J14 – Excludes Other JTAG TDI-TDO
J15 – Includes MachXO2280 JTAG TMS
J18 – Includes POWR1014A JTAG TMS

Remove Jumpers
J19 – Excludes Other JTAG TMS
J5 – Includes MachXO2280 JTAG TDI-TDO
J9 – Includes POWR1014A JTAG TDI-TDO

See Schematic 1 of 10 for details on the MachXO Control Evaluation Board jumper settings.
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2. Adjust the following jumpers to connect the on-board supply monitor circuits.

Install Jumper
J17 – Enable MachXO2280 Vccio monitor circuit

Remove Jumper
J22 – Enable MachXO2280 Vccaux monitor circuit

See Schematic 8 of 10 for details of the voltage monitor input circuits.

3. Ensure SW 4, position 2, of the POWR1014A DIP Switch is in the raised position. When in the lowered position 
it will assert manual reset to the system.

4. Plug in the power supply to an outlet and the Power Socket. After a connection is made, a red Power LED 
(D18) will light up indicating the board is powered on.

5. Connect the USB cable provided from a USB port on your PC to the board’s USB interface socket (J8) on the 
side of the board as shown in the layout diagram below. 

6. If you are prompted, Windows may connect to Windows Update select No, not this time from available 
options and click Next to proceed with the installation. Choose the Install from specific location (Advanced) 
option and click Next. 

7. Select Search for the best driver in these locations and click the Browse button to browse to the Windows 
driver folder created earlier. Select the CDM 2.04.06 WHQL Certified folder and click OK.

8. Click Next. A screen will display as Windows copies the required driver files. Windows will display a message 
indicating that the installation was successful.

9. Click Finish to install the USB driver. 

10. Right-click the ispPAC-POWR1014A entry and choose Edit Device… The Device Information dialog appears.

11. From the Operation list, select Bypass.
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Set Up Windows HyperTerminal
You will use a terminal program to communicate with the evaluation board. The following instructions describe the 
Windows HyperTerminal program which is found on most Windows PCs. You may use another terminal program if 
you wish although setup will be somewhat different. For Linux, Minicom is a good alternative.

Note: This step uses the procedure for Windows XP users. Steps may vary slightly if using another Windows ver-
sion.

1. From the Start menu, select Control Panel > System. The “System Properties” dialog appears.

2. Select the Hardware tab and click Device Manager. The “Device Manager” dialog appears.

3. Expand the Ports (COM & LPT) entry and note the COM port number for the USB Serial Port.
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4. From the Start menu, select Programs > Accessories > Communications > HyperTerminal. The HyperTer-
minal application and a “Connection Description” dialog appear.

5. Specify a Name and Icon for the new connection. Click OK. The “Connect To” dialog appears.

6. Select the COM port identified in Step 3 from the Connect using: list. Click OK.

7. The “COMn Properties” dialog appears where n is the COM port selected from the list.

8. Select the following Port Settings and click OK.

Bits per second: 115200
Data bits: 8
Parity: None
Stop bits: 1
Flow control: None
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The HyperTerminal window appears.

9. From the MachXO Control Evaluation Board, press the MachXO2280 GSR Input push-button. The Control 
SoC demo Main Menu appears.

The user interface will provide the menu-driven interface shown in Table 1. 

Table 1. Main Menu

===============================================================
Welcome to the MachXO Control Evaluation Board
Control SoC Demo Rev 1.0, June 2009

0: Re-display Main Menu
1: Read Board Uptime
2: Read Current Board Status
---------------------------------------------------------------
n  : Normalize Temp Output
H/h: +/- Fan Temp Threshold (0.25C)
b  : Backlight Intensity (H/L)
C/c: +/- LCD Contrast
f  : Change Fan Speed 
s  : Read SPI Flash IDCode
t  : Read I2C Temp Sensor
d  : Read XO2280 DIP Switches
u  : Read POWR1014A UES

===============================================================
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Set Up Linux Minicom
Minicom is a terminal program found with most Linux distributions. It can be used to communicate with the 
MachXO Control Evaluation Board. 

To setup Minicom:

1. Check active serial ports:
#dmesg | grep tty
Note the tty label assigned to the USB port.

2. From a command prompt, start Minicom:
#minicom -s
The configuration menu appears.

3. Highlight Serial port setup and press Enter.
Serial port settings appear.

4. Press A (Serial Device).
Specify the active serial device noted in Step 1 and press Enter.

5. Press E (Bps/Par/Bits).
Specify 115200, None, 8 and press Enter.

6. Press F (Hardware Flow Control).
Specify None and press Enter.

7. Press Esc.
The configuration menu appears.
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8. Select Save setup as dfl.
Minicom saves the port setup as the new default.

9. Select Exit.
The Minicom interface appears.

10. From the evaluation board, press the G2 push-button (GSR).
The Control SoC demo Main Menu appears.

Power Supply Sequencing
Supply sequencing by the POWR1014A can be visualized on the MachXO Control Evaluation Board with the 
POWR1014A LED bank. 

To cycle the manual reset and observe power-on management:

1. Press toggle switch position 2 of SW4.

An evaluation board manual reset is continuously cycled.

Upon each reset event, the POWR1014A sequences five supply rail circuits of the MachXO Control Evaluation 
Board: Vccio, Vcccore, Vccaux, and two high-voltage ramp circuits (see Schematic Sheet 7 of 10). LEDs D5-
D6 of the POWER1014A LED bank are binary encoded to represent the three Vcc supply sequence, in order: 
Vccio, Vcccore, and Vccaux. 

LEDs D7-D8 of the POWER1014A LED bank light when the voltage ramp circuits monitored by VMON7 and 
VMON8 are enabled by the high-voltage outputs (HVOUT1 and HVOUT2) of the POWR1014A.

Supplies Enabled D5 D6 D7 D8

None

Vccio X

Vccio AND Vcccore X

Vccio AND Vcccore AND Vccaux X X

HVOUT1/VMON7 X

HVOUT1/VMON7 AND HVOUT2/VMON8 X X

2. Raise toggle switch position 2 of SW4.

A MachXO Control Evaluation Board manual reset is released.

Read Current Board Status
Board status is monitored continuously by the MachXO2280 and POWR1014A after the power-on stage of the 
evaluation board logic. 

To read board status:

In the terminal window press 2. Status of the board appears including uptime since last reset, board temperature, 
fan speed (a relative speed number), and voltage/current measurements of three supply rails. 

Example:

Uptime:   000h54m50s

Temp:29.50oC
Fan Speed:000

Core: 3.103V / 55.2mA
Aux : 3.187V / 13.2mA
I/O : 3.247V / 24.6mA
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To measure supply rail variations:

1. To disconnect the Vccio rail connection to the MachXO2280, remove jumper J17 from the MachXO Control 
Evaluation Board. The Vccio supply rail is disconnected. 

2. From the terminal window, press 2. Status of the board appears.

Example:

Uptime:   000h55m05s

Temp:29.50oC
Fan Speed:000

Core: 3.103V / 55.2mA
Aux : 3.187V / 13.2mA
I/O : 0.007V / 24.6mA

The Vccio supply rail measurement indicates ~0V.

Note: Vccio current (ICCIO_Sense) is not affected by removing the jumper at J17. See Schematic Sheet 8 of 
10 for details.

3. Install a jumper at J22. The Vccaux voltage divider circuit is connected. From the terminal window, press 2. 
Status of the board appears.

Example:

Uptime:   000h56m30s

Temp:29.25oC
Fan Speed:000

Core: 3.103V / 55.2mA
Aux : 1.597V / 14.9mA
I/O : 0.007V / 24.6mA

The Vccaux supply rail measurement indicates ~1.5V.

Note: Vccaux current (ICCAUX_Sense) is not affected by installing the J22 jumper. See Schematic Sheet 8 of 
10 for details.

To read PCB temperature:

1. Place your finger on the on-board Temperature Sensor (U15) for 2-5 seconds. Depending on your skin temper-
ature, the level should influence the temperature monitor (1 LED=0.25C). 

2. From the terminal window, press 2. Status of the board appears.

Example:

Uptime:   000h56m30s

Temp:29.75oC
Fan Speed:000

Core: 3.103V / 164.4mA
Aux : 1.597V / 14.9mA
I/O : 0.007V / 24.6mA

The temperature monitor varies over time depending on the I2C temperature sensor reading.
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Normalize PCB Temperature Output
You can calibrate the Control SoC temperature sense logic to account for the ambient conditions of the PCB. The 
MachXO2280 LED bank displays relative temperature of the PCB as a level meter. The normalize feature will reset 
the median temperature level and light 4 of 8 LEDs.

To normalize the temperature output:

From the terminal window, press n. The Control SoC normalizes the meter output for the ambient temperature and 
lights 4 (D1-D4) of the MachXO2280 LED bank.

Adjust Fan Temperature Threshold
The Control Evaluation Board includes a small fan controlled by a pulse width modulated (PWM) output module of 
the Control SoC design. The fan enable is a function of a temperature threshold setting. By default, the threshold is 
set at the median of the normalized ambient temperature. You may increase or decrease the threshold in steps of 
~0.25C.

To adjust fan temperature threshold:

1. Note the fan operation.

2. If the fan is on, from the terminal window, press H. The control design raises the temperature threshold by 
+0.25C. If the fan does not turn off, continue pressing H until the threshold is higher than the PCB temperature.

If the fan is off, from the terminal window, press h. The control design drops the temperature threshold by -
0.25C. If the fan does not turn on, continue pressing h until the threshold is lower than the PCB temperature.

Change Fan Speed
When the evaluation board fan is operational as determined by the fan temperature threshold, the Fan speed can 
be set to one of the following fan speeds:

  None: 000
  Low: ~175
  Medium: ~222
  High: ~234

To adjust fan speed:

1. Note the fan operation.

If the fan is off, from the terminal window, press h. The control design drops the temperature threshold by -
0.25C. If the fan does not turn on, continue pressing h until the threshold is lower than the PCB temperature 
and the fan turns on.

2. From the terminal window, press f. The Fan speed setting appears.

Example:

Fan: Off

The fan is turned off.

3. Press f. The Fan speed setting appears.

Example:

Fan: Low

The fan is turned on with the low (175) speed.
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4. Press f. The Fan speed setting appears.

Example:

Fan: Med

The fan is turned on with the medium (222) speed.

Adjust LCD Backlight Intensity
If an LCD panel (not included in the Control Development Kit) with a backlight feature is installed to header J13, 
you may adjust the backlight intensity.

To adjust LCD panel backlight intensity:

From the terminal window, press b. The backlight intensity increases.

Adjust LCD Contrast
If an LCD panel (not included) is installed to header J13, you may adjust the LCD contrast between the display seg-
ments and the background.

To adjust LCD panel contrast:

From the terminal window, press C to increase or c to decrease.

Read the SPI Flash Memory IDCode
This demo uses SPI Flash Memory Controller and UART modules of the Control SoC to scan the memory device 
identification code of the on-board SPI Flash Memory and display it on the terminal output. The transaction is 
logged to the on-board SRAM through the SRAM controller module.

To scan the SPI Flash Memory IDCode:

From the terminal Main Menu, press s. The IDCode is returned as a hex value.

Example:

ID:0x12

Note: The IDCode for your board may differ.

Read the I2C Temperature Sensor
This demo uses the I2C Controller and UART modules of the Control SoC to read the on-board I2C temperature 
sensor, convert the raw data to Celsius units and display it on the terminal output. 

To monitor temperature:

From the terminal window press t. The current temperature in degrees Celsius appears.

Example:

Temp:30.50°C

Read MachXO2280 DIP Switch Inputs
This demo uses the UART module of the Control SoC to read the user-input switch inputs 8-1 (MSB-LSB) of the 
DIP Switch Bank (SW2) and output it to the terminal as a hex value. Switch numbers are marked on the DIP switch 
body. A raised switch indicates a logical True (1).

To read the DIP Switch:

From the terminal window press d. The switch setting is returned as a hex value.
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Example:

SW:0xFF       

Read POWR1014A UES
This demo uses the I2C module of the Control SoC to read the UES (User Electronic Signature) of the 
POWR1014A. The UES consists of 32 bits that can be configured to store unique data such as inventory control 
data.

To read the POWR1014A UES:

From the terminal window press u.

The UES is returned as a hex value.

Example:

UES:CB1014A1 

Note: The POWR1014A UES for your board may differ.

Read Board Uptime
Board uptime is the period in hours, minutes, and seconds elapsed since the last MachXO2280 power-on or global 
reset event. Board uptime can be a useful metric for system reliability.

To read board uptime:

In the terminal window press 1. Uptime status of the board appears. 

Example:

Uptime:   000h40m18s

Re-Display the Main Menu
During the demo session the main menu will scroll off screen. To redisplay the menu, press 0. 

Voltage Monitoring Demo
This demo showcases RD1066, Simple Sigma Delta ADC Reference Design, to monitor an analog voltage and 
convert it to a digital value using only two passive external components. The demo board must be modified to dem-
onstrate this unique ability (please refer to the section “Modifying the MachXO Control Evaluation Board” for 
detailed instructions). Alternatively, the design may be evaluated using the control board without modification 
(please refer to the section “Alternate ‘No-Rework’ Voltage Monitoring Demo” below).

Figure 4. SSD ADC Functional Block Diagram
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Referencing the functional block diagram in Figure 4, the following logic blocks are implemented in the PLD:

• Comparator (External implementation option)

• Sampling Element

www.latticesemi.com/dynamic/view_document.cfm?document_id=35762
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• Accumulator with decimation

• Digital Low-Pass Filter with decimation

An 8-bit ADC with sampling frequency of 7.63KHz has been implemented for this demo. For detailed technical 
information on the ADC converter, reference RD1066, Simple Sigma Delta ADC Reference Design.

The demo asks the user to download the configuration pattern of the MachXO device from the following directory:

…\Demo_MachXO_Control_ADC_Voltage_Monitor\Project

The configuration pattern is in JEDEC file XO_Voltage_Monitoring_Demo_Int.jed

Connect a voltage source to pin ‘ProtoP9’ of the new header. Make sure the ground of the voltage source is con-
nected to the GND pin of the new header (or a ground pad on the board). The voltage source must be between 0V 
and 3.2V. 

Press reset switch SW1. The LEDs will display the digital value of the analog voltage provided by the voltage 
source. The LED field will read out a value 0-255 in proportion to the input voltage.

Vary the analog voltage source and observe the digital output on the LEDs, which will track the analog voltage 
source.

Alternate ‘No-Rework’ Voltage Monitoring Demo
RD1066 may be implemented utilizing the existing on-board external comparator, U16.  This allows the character-
ization of the digital filters without board modification, if desired.

For this version of the demo, the configuration pattern is in JEDEC file XO_Voltage_Monitoring_Demo_Ext.jed

Connect a voltage source to pin 2 of header J23. Make sure the ground of the voltage source is connected to a 
ground pad on the board.

Memory-Audio Demo
The Memory-Audio Demo showcases the LatticeMico8 and two new peripherals that Lattice has developed. These 
peripherals are a CompactFlash memory controller and the Audio Player PWM DAC.

This exciting demo asks users to connect the MachXO Control Evaluation Board to the USB port of a personal 
computer and download wave files (filename.wav) to CompactFlash memory through the USB port. During this 
transaction, LatticeMico8 plays a crucial role in receiving the stream of data and writing it to the CompactFlash 
memory.

With a computer, users are able to send commands to the LatticeMico8 and select the wave file they would like to 
be played by the Audio Player PWM DAC. During this transaction, the LatticeMico8 interprets user keystroke com-
mands, reads data from the CompactFlash memory and sends the data to Audio Player PWM DAC.

www.latticesemi.com/dynamic/view_document.cfm?document_id=35762
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Figure 5. Functional Block Diagram
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The darker blocks of the diagram highlight the embedded resources in the MachXO device.

PC Host
Users employ a HyperTerminal program to communicate with the MachXO Control Evaluation Board. From the 
HyperTerminal, they are able to:

• Transfer a wave file to the CompactFlash memory card

• Select the wave file, which the LatticeMico8 will read from the CompactFlash memory card and send ito the 
Audio Player PWM DAC

LatticeMico8 Microcontroller
The LatticeMico8 is an 8-bit microcontroller optimized for Field Programmable Gate Arrays (FPGAs) and Program-
mable Logic Device architectures from Lattice.  In this demo, it performs the following tasks:

• Receives wave files and writes them to the CompactFlash memory card.  (User transfers the wave files through 
the HyperTerminal program).

• Receives commands from the user, indicating the wave file to be played.  (User provides commands through the 
HyperTerminal program).

• Reads a specific wave file from the CompactFlash memory card and sends it to the Audio Player PWM DAC.

UART
The Lattice WISHBONE UART provides an interface between the WISHBONE UART system bus and an RS232 
serial communication channel. Reference Design RD1042, WISHBONE UART has been implemented in this 
demo.

CompactFlash Memory Controller
This embedded controller has wishbone interface and it is a peripheral component to the LatticeMico8 microcon-
troller. Reference Design RD1040, CompactFlash Controller has been implemented in this demo.

Audio Player PWM DAC

This is an embedded digital-to-analog converter with WISHBONE interface and it is a peripheral component to the 
LatticeMico8 microcontroller.

www.latticesemi.com/dynamic/view_document.cfm?document_id=32336
www.latticesemi.com/dynamic/view_document.cfm?document_id=32333
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Memory-Audio Demo
Before you start, ensure that you have:

• A MachXO Control Evaluation Board connected to your computer through a USB connection and programmed 
with JED file control_soc_demo.jed.

• A CompactFlash card plugged into the MachXO Control Evaluation Board CF connector J16

• Headphones or speakers plugged into the MachXO Control Evaluation Board Audio connector Q3

• Wave file mono <5 MB, 8 bit, mono

To run the demo:

1. Using a HyperTerminal program, connect to the MachXO Control Evaluation Board.

Figure 6. Startup Screen

2. Press u to begin uploading a song.

3. You will be prompted that existing data on the CompactFlash card will be overwritten. Press y to continue.

Figure 7. Uploading a Song/Wave File

4. Select a number to be associated with the song (1-9).
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5. Ensure the protocol to transfer the file is Xmodem then select the file to upload. Toggle any switch on SW2 to 
begin uploading the file. The File progress window will update and the LEDs on the MachXO Control Evalua-
tion Board will toggle.

Figure 8. Upload a File

Figure 9. Select File to Upload with Xmodem Protocol
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Figure 10. File Upload Status

6. The file is uploaded and ready to be played. Press p then a number to select the song to play. At any time, 
press x to stop the playing of the song.

Figure 11. Select a Song to Play

Power Supply Fault Logging Demo
This demo showcases a solution for detecting and logging power supply fault conditions in non-volatile memory. 
The demo is based on the reference design Power Supply Fault Logging (RD1062). Additional reference designs to 
build the system include:

• RD1042, WISHBONE UART

• RD1043, LatticeMico8 to WISHBONE Interface Adapter

• RD1044, SPI WISHBONE Controller

• RD1026, LatticeMico8 Microcontroller

www.latticesemi.com/dynamic/view_document.cfm?document_id=35227
www.latticesemi.com/dynamic/view_document.cfm?document_id=32336
www.latticesemi.com/dynamic/view_document.cfm?document_id=32337
www.latticesemi.com/dynamic/view_document.cfm?document_id=32338
www.latticesemi.com/dynamic/view_document.cfm?document_id=9967
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Figure 12. Power Supply Fault Logging Demo Block Diagram
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Arbitration logic and handshaking between the LatticeMico8 microcontroller and the Power Supply Fault Logging
reference design (RD1062) is implemented to prevent contention with the interface signals of the SPI memory.

During this demo, the user will trigger faults in voltage rails monitored by Power Manager II ispPAC-POWR1014A, 
which will detect the faults and enable a dump of VMON status to the MachXO. The dump of VMON status is imple-
mented using supervisory logic equations and happens automatically using outputs and clock pins of the Power 
Manager II. The MachXO will log the VMON status to SPI memory.  The user is able to read  the logged VMON sta-
tus from SPI memory using the HyperTerminal interface of a personal computer.

Demo Environment Setup
The user will first set up the MachXO Control Evaluation Board by populating jumpers in headers J17 and J22. 
These jumpers will later be used to trigger a fault condition during the demonstration. Next, program the Power 
Manager II and MachXO devices with the configuration patterns of this demo. The JEDEC files with the configura-
tion patterns are located in the following directories:

…\MachXO_Control_PowerSupplyFaultLogging_Demo\project\MachXO

…\MachXO_Control_PowerSupplyFaultLogging_Demo\project\POWR1014A

Establish a HyperTerminal communication between the personal computer and the MachXO Control Evaluation 
Board as previously described in this document. Press on the pushbutton S1 to reset the board. Upon release of 
the reset line, the LatticeMico8 will transmit a menu of options through the UART to the HyperTerminal as shown in 
Figure 13.

www.latticesemi.com/dynamic/view_document.cfm?document_id=35227
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Figure 13. HyperTerminal Window

• Option 1 of the menu will display the total number of faults logged in SPI memory.  

• Option 2 of the menu will display the latest fault that was logged in SPI memory.

• Option 3 of the menu will step one-by-one through all the faults that were logged in SPI memory.  

• Option 4 of the menu will clear all the faults that were logged in SPI memory.

The demo design is configured to capture and log up to 251 faults in SPI memory. A message indicating that the 
SPI memory is full will be displayed in the HyperTerminal window in case the maximum number of faults is reached. 

Trigger Fault Conditions
Below is a list of fault conditions that users can cause on the board. After a fault condition is caused, the user can 
use menu options 1-3 to read the faults logged in SPI memory. 

Fault conditions:

1. VMON2: Under volt if test point I/O 25 is shorted to test point I/O 26.

2. VMON2: Over volt if a 1KOhm resistor is shorted from test point I/O 26 to GND.

3. VMON3: Under volt if test point I/O 17 is shorted to test point I/O 19

4. VMON3: Over volt if a 1KOhm resistor shorts test point I/O 19 to GND

5. VMON4: Under volt if jumper J17 is removed. Remove jumper for less than two seconds.

6. VMON5: Over volt if jumper J22 is removed. Remove jumper for less than two seconds.

7. VMON7: Under voltage if 1KOhm resistor shorts HVO1 to GND.

8. VMON8: Under voltage if 1KOhm resistor shorts HV02 to GND.

When any of the above faults happen VMON9 and VMON 10 will have faults based on the settings of SW4:  SW4.1 
emulates comparator A status and SW4.2 emulates comparator B status.

There is a 2-second delay after a fault to prevent double faults before the sequence restarts. 
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The image below shows the HyperTerminal window after an over volt fault was caused on VMON5 and the user 
selected options 1 and 2 of the menu.  

If desired, users can modify the assembly program for this demo by using the updated LatticeMico8_V3.01 assem-
bler from the following directory:

…\MachXO_Control_PowerSupplyFaultLogging_Demo\LatticeMico8_V3_01_Util\

Download Demo Designs
Lattice distributes source and programming files for a variety of demonstration designs compatible with the 
MachXO Control Evaluation Board. 

To download demo designs:

1. Browse to the MachXO Control Development Kit web page at www.latticesemi.com/machxo-control-kit. Select 
the Demo Applications download and save the file.

2. Extract the contents of MachXO_Control_Dev_Kit.zip to an accessible location on your hard drive.

Five demo design directories are unpacked.

www.latticesemi.com/machxo-control-kit


Demo Directories Revision

MachXO2280 Control SoC Demo Demo_MachXO_Control_SoC
.\LatticeMico8_V3_0_Verilog
.\project
.\RD1042
.\RD1043
.\RD1044
.\RD1046
.\RD1053
.\RD1060
.\source

1.0

POWR1014A Board Management (BM) Demo Demo_PM_Control_BM 1.0

Voltage Monitoring Demo Demo_MachXO_Control_ADC_Voltage_Monitor
.\project
.\RD1066
.\source
.\testbench 

1.1

Memory-Audio Demo Demo_MachXO_Control_Mem_Audio
.\project
.\RD1040
.\RD1042
.\RD1043
.\RD1044
.\RD1048
.\RD1053
.\Wave_Files

1.0

Power Supply Fault Logging Demo Demo_MachXO_Control_FaultLogging
.\LatticeMico8_V3_0_Verilog
.\LatticeMico8_V3_01_Util
.\project
.\RD1042
.\RD1043
.\RD1044
.\source

1.0
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Where:

• .\project – ispLEVER project (.syn) or PAC-Designer project (.pac), preferences (.lpf), and programming file 
(.jed). This directory may contain intermediate results of the ispLEVER/PAC-Designer build process.

• .\source – HDL source for the ispLEVER project.

• .\LatticeMico8_V3_0_Verilog – RD1026, LatticeMico8 Microcontroller User’s Guide

• .\rdxxxx – Reference designs integrated by a demo.

Programming Demo Designs with ispVM
The Control SoC demo design is pre-programmed into the MachXO Control Evaluation Board by Lattice. To restore 
a board to factory settings or load an alternative demo design, use the procedure in this section.

To program a demo programming file:

1. Connect the MachXO Control Evaluation Board USB connector (J8) to a host PC.

2. Connect the included 5V adapter to the MachXO Control Evaluation Board power connector (J10).

3. Ensure the JTAG chain jumpers are set properly to include the MachXO and POWR1014A devices (See Figure 
X).
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4. From the Start menu run ispVM System. ispVM appears.

5. Choose Options > Cable and IO Port Setup… The Cable and I/O Port Setup dialog appears.

6. Click Auto Detect. ispVM will detect Cable Type USB and Port Setting USB2.

7. Click OK.

8. Choose ispTools > Scan Chain. The New Scan Configuration Setup window appears. Bot the LCMXO2280 
and POWR1014A appear in the device list.

9. Right-click the LCMXO2280C entry and choose Edit Device… The Device Information dialog appears.

10. From the Data File section, click the Browse button. The Open Data File dialog appears.

11. Browse to the <Demo Dir>\project folder, select <Demo>.jed, and click Open.



29

 
Lattice Semiconductor MachXO Control Development Kit User’s Guide 

From the Operation list choose FLASH Erase, Program, Verify and click OK.

12. Choose Project > Download. ispVM reprograms the MachXO Control Evaluation Board.

Programming requires about 20-40 seconds. A small timer window will appear to show elapsed programming 
time. At the end of programming, the configuration setup window should show a PASS in the Status column.

Rebuilding a MachXO Demo Project with ispLEVER
Use this general procedure here to rebuild any of the MachXO2280 demo projects for the MachXO Control Evalua-
tion Board. 

1. Install and license ispLEVER software

2. Install and license ispVM System software.

3. Download the demo source files from the MachXO Control Development Kit Webpage at www.lattices-
emi.com/machxo-control-kit. 

4. Run the ispLEVER Project Navigator.

5. Create a new project and add the HDL files from the <demo>\source directory. Note that some demos provide 
a <demo>.syn project file.

6. Import the logical preference file (<demo>.lpf) with I/O plan and timing requirements.

7. Run the Generate Data File (JEDEC) process.

8. See the Programming Demo Designs with ispVM section of this document for details on downloading a pro-
gramming file to the board.

www.latticesemi.com/machxo-control-kit
www.latticesemi.com/machxo-control-kit
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Reassembling the Demo LatticeMico8 Firmware
Use this general procedure to reassemble and download changes to the LatticeMico8 microcontroller firmware.

1. Install the LatticeMico8 Tool Code Revision 3.0 from
www.latticesemi.com/products/intellectualproperty/referencedesigns/8bitmicrocontrollermico8.cfm

Note: The LatticeMico8 tool executables are also provided in the
.\Demo_MachXO_Control_SoC\LatticeMico8_V3_0_Verilog\utils directory.

2. Compile the LatticeMico8 Assembler and Simulator (optional)

3. Modify the Assembly source (.s) file and recompile to a memory image (.hex). Source for the Control SoC 
demo is provided as control_soc_demo.s.

4. Use the Memory Initialization tool of the ispLEVER Project Navigator to update the physical database NCD.

5. Rerun Generate Data File (JEDEC) process.

6. See the Programming Demo Designs with ispVM section of this document for details on downloading a pro-
gramming file to the MachXO Control Evaluation Board.

Recompiling a Power Manager II Demo Project with PAC-Designer
Use the general procedure here to rebuild any of the POWR1014A demo projects for the MachXO Control Evalua-
tion Board. 

1. Install and license PAC-Designer software

2. Install and License ispVM System software.

3. Download the demo source files from the MachXO Control Development Kit Webpage at www.lattices-
emi.com/machxo-control-kit. 

4. Run PAC-Designer.

5. Open the PAC-Designer project file (<demo>.pac) from the <demo>\source directory. 

6. Double-click the Sequence Controller block.

7. Choose Tools > Compile LogiBuilder Design.

Note: To program the POWR1014A device, the MachXO device must be removed from the JTAG chain by setting 
the JTAG jumpers (see Figure X). Because the power to the MachXO device is controlled by the POWR1014A, it 
cannot be in the JTAG chain during POWR1014A updates.

MachXO Control Evaluation Board
This section describes the features of the MachXO Control Evaluation Board in detail.

Overview
The MachXO Control Evaluation Board is an AC-powered development platform for the MachXO PLD. The board 
includes on-board SRAM and SPI Flash memory, I2C and SPI microcontroller communication interfaces, a USB 
program/debug port, and an expansion header to support test connections. 

www.latticesemi.com/products/intellectualproperty/referencedesigns/8bitmicrocontrollermico8.cfm
www.latticesemi.com/machxo-control-kit
www.latticesemi.com/machxo-control-kit


31

 
Lattice Semiconductor MachXO Control Development Kit User’s Guide 

Figure 14. MachXO Control Evaluation Board Block Diagram
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Table 2 describes the components on the board and the interfaces it supports.

Table 2. MachXO Control Evaluation Board Components and Interfaces 

Component/Interface Type Schematic Reference Description

Circuits

USB Controller Circuit U3:CY7C68013A-QFN56 USB-to-JTAG interface

USB to Serial (RS-232) Circuit U1:FT232R / 32-QFN USB-to-Serial interface

Components

62.5 MHz Oscillator Clock U38 MachXO clock source

1Mbit SRAM Memory U8:CY128X8TSOP 1Mb of SRAM

MachXO PLD PLD U60:MachXO_2280_FN256 LCMXO2280FN256

POWR1014A PLD U17:ispPAC-POWR1014A ispPAC-POWR1014A

I2C Temperature Sensor I/O U15:TMP101 Measures board temperature

2Mbit SPI Flash Memory Memory U4 2Mb FLASH memory

8 LEDs Output D7-D0 User-definable LEDs

Interfaces

2X16 Header I/O J6 User-definable I/O 

USB Control B Sockets I/O J1, J8 Programming and debug interface

Push-button switches I/O S1, S2 GSR and Sleep push buttons

Jumper I/O J2 MachXO Core current

Jumper I/O J3 MachXO AUX current

Jumper I/O J4 MachXO I/O current

Jumper I/O J6 MachXO TSALL input
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Subsystems
This section describes the principle subsystems for the MachXO Control Evaluation Board in alphabetical order.

CompactFlash Card Socket
A CompactFlash card socket (J16 - Schematic Sheet 2 of 10) will accept both Type I and Type II cards.

Table 3. 

Item Description

Reference Designators J16

Part Number CF_Socket

Manufacturer AVX

Part Number AVX-31-5620-050-116-871

CompactFlash Socket Reference

Tested CF Flash Memory Card: SanDisk 64MB

Current Sensor Circuits
The MachXO Control Evaluation Board provides three resistive current sensing circuits (Schematic Sheet 7 of 10) 
using the technique described in AN6049, High-side Current Sensing Techniques for Power Manager Devices. You 
may measure current consumption of the MachXO2280 Vcccore, Vccaux, or Vccio through the POWR1014A volt-
age supervisor function. 

Digital Potentiometer Circuit
An I2C addressable digital potentiometer (U44 – Schematic Sheet 4 of 10) is programmable to adjust the LCD 
backlight and contrast and optionally provide a variable input voltage for the Delta-Sigma ADC circuit. 

Fan Circuit 
A 3-pin fan motor header and circuit supports a DC fan motor (Schematic Sheet 3 of 10). 

GPIO Expansion Header Land Patterns
The MachXO Control Evaluation Board provides land patterns for two 40-pin general purpose I/O (GPIO) expan-
sion headers (J4 and J7 – Schematic Sheet 2 of 10), a 38-pin header for MachXO2280 GPIO access, and one 14-
pin header for debug access. All land patterns are organized for 100mil centered pin headers.

J4 and J7 Land Patterns: J4 and J7 patterns are for two 40-pin expansion headers. The combination provides 46 
user I/Os connected to the MachXO2280. The remaining pins serve as power and clock supplies for expansion 
boards. I/Os are shared with the CompactFlash socket. The connector spacing, orientation, and I/O connections 
match expansion board from Gleichmann Engineering. See the Gleichmann Hpe Expansion board page at 
(http://www.ger-fae.com/hpe_expansion.html) for an example.

Jumper I/O J17 Connects Vccio

Jumper I/O J22 Grounds Vccaux

Table 4. Header J4 Pin Information 

Function J4 Pin MachXO Pin CompactFlash Socket Pin

GPIO_RST 1 E8

GND 2

IO0 3 E9 2

IO1 4 A10 3

IO2 5 A9 4

IO3 6 C9 5

IO4 7 C10 6

Table 2. MachXO Control Evaluation Board Components and Interfaces (Continued)

www.latticesemi.com/dynamic/view_document.cfm?document_id=5940
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IO5 8 D9 7

IO6 9 D10 8

IO7 10 B9 9

IO8 11 B10 10

IO9 12 A11 11

IO10 13 A12 12

IO11 14 B11 14

IO12 15 B12 15

IO13 16 C11 16

IO14 17 C12 17

IO15 18 A13 18

GND 19

+3.3V 20

IO16 21 A14 19

GND 22

IO17 23 D11 20

GND 24

IO18 25 D12 21

GND 26

IO19 27 E10 22

IO20 28 E11 23

IO21 29 B13 24

GND 30

IO22 31 C13 25

IO23 32 B14 26

IO24 33 C14 27

GND 34

IO25 35 A15 28

IO26 36 B15 29

IO27 37 B3 30

GPIO_CARDSEL# 38 B2

IO28 39 A2 31

GND 40

Table 5. Header J7 Pin Information 

Function J7 Pin MachXO Pin CompactFlash Socket Pin

GND 1

NC 2

3.3V 3

IO29 4 A3 32

IO30 5 D3 33

IO31 6 D4 34

IO32 7 C4 35

Table 4. Header J4 Pin Information (Continued)

Function J4 Pin MachXO Pin CompactFlash Socket Pin
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IO33 8 C5 36

IO34 9 D6 37

IO35 10 D5 39

IO36 11 B4 40

IO37 12 B5 41

IO38 13 E7 42

IO39 14 E6 43

IO40 15 A5 44

IO41 16 A4 45

IO42 17 C6 46

IO43 18 C7 47

IO44 19 B6 48

IO45 20 B7 49

5V 21

GND 22

3.3V 23

GND 24

3.3V 25

GND 26

3.3V 27

GND 28

OSC_CLK 29

GND 30

IO46 31 A6

GND 32

IO47 33 A7

GND 34

3.3V 35

GND 36

3.3V 37

GND 38

3.3V 39

GND 40

Table 5. Header J7 Pin Information (Continued)

Function J7 Pin MachXO Pin CompactFlash Socket Pin
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38-Hole Land Pattern: The MachXO Control Evaluation Board provides a 38-hole landing area with connections to 
POWR1014A and MachXO2280 support circuits (Schematic Sheet 8 of 10). 

Table 6. 

Function Pin POWR1014A Pin Other Connections

HVOUT1 IO9 15

HVOUT2 IO54 14

PM_I2C_ALERT IO55 13

PM_OUT8 IO33 8

PM_OUT9 IO11 6

PM_OUT10 IO56 5

PM_OUT11 IO53 4

PM_OUT12 IO57 3

XO_RESET IO59 2 XO2280 GSR push-button circuit

XO_Sleepn IO60 1 XO2280 Sleep push-button circuit

PM_PLDCLK IO61 42

PM_MCLK IO85 43

VMON7 IO65 34

VMON8 IO66 35

VMON9 IO67 36

VMON10 IO68 37

ICC_Sense IO69 25

ICCAUX_Sense IO70 26

ICCIO_Sense IO71 27

38-Pin Landing Pattern Pin Information

14-Hole Land Pattern: The MachXO Control Evaluation Board provides a 14-hole landing area with connections to 
key SPI bus and DAC/ADC circuit nets (Schematic Sheet 3 of 10). 

Table 7. 

Function Pin

XO_SPI_CS0 IO7

GND_6

XO_SPI_CLK IO52

GND_50

XO_SPI_OUT IO30

GND_29

XO_SPI_IN IO8

GND_7

A2D_DS_IN IO50

GND_51

D2A_OUT IO28

GND_30

Fan_Trigger IO28

GND_33

14-Hole Landing Pattern Pin Information
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JTAG Jumpers
Two jumper circuits (Schematic Sheet 1 of 10) allow you to define the MachXO Control Evaluation Board’s JTAG 
chain of installed devices. You may specify the Installed/Removed state for the MachXO2280 and POWR1014A of 
the board. Additionally you can connect an external JTAG circuit by attaching to IO20, IO22, and IO24 test points. 
See the Jumper Settings table of Schematic Sheet 1 for details.

LCD Panel Support Circuit
The MachXO Control Evaluation Board provides support circuitry and connector (Lumex LCM-S02002DSR. Note: 
Assembly to generic 16-pin (2x8) header is required, for example, Sullins Connector Solutions PPPC082LFBN-
RC), Schematic Sheet 4 of 10. The LCD is connected to GPIOs of the MachXO and backlight/contrast controls. 

Table 8. 

Function J13 Pin

LCD_BACKLIGHT 1

GND 2

GND 3

+5V 4

LCD_CONTRAST 5

LCD_RS 6

LCD_RW 7

LCD_E 8

LCD_D0 9

LCD_D1 10

LCD_D2 11

LCD_D3 12

LCD_D4 13

LCD_D5 14

LCD_D6 15

LCD_D7 16

LCD_BACKLIGHT 17

GND 18

LCD Connector Pin Information

MachXO PLD (MachXO2280)
The MachXO PLD device (LCMXO2280C-4F256C) on the board provides 2280 LUTs, 7.5 Kbits of distributed 
RAM, 27.6 Kbits of EBR SRAM, 211 user I/Os in a 17x17 mm ftBGA package. 

Table 9. 

Item Description

Reference Designators U60A, U60B, U60C, U60D, U60E

Part Number LCMXO640/1200/2280-FT256/FTN256

Manufacturer Lattice Semiconductor Corporation

Web Site www.latticesemi.com

MachXO2280 Reference

This following sections describe user access to the LCMXO2280FTN256 device.

MachXO2280 DIP Switch Bank Input: The MachXO Control Evaluation Board includes an eight-bit input toggle 
switch tied to GPIOs of the MachXO (SW2 – Schematic Sheet 4 of 10). When in the open position, the switch is 
pulled to 3.3V via a 10K resistor. When in the down position, the switch is tied to ground. 

http://www.latticesemi.com


37

 
Lattice Semiconductor MachXO Control Development Kit User’s Guide 

Table 10. 

Function SW2 Pin MachXO Pin

SW7 1 T13

SW6 2 T12

SW5 3 R13

SW4 4 R14

SW3 5 T14

SW2 6 T15

SW1 7 R15

SW0 8 R16

GND 9

GND 10

GND 11

GND 12

GND 13

GND 14

GND 15

GND 16

DIP Switch Pin Information

MachXO2280 LED Bank: The evaluation board includes an eight LED tied to GPIOs of the MachXO (Schematic 
Sheet 4 of 10). Driving logic low ‘0’ will light an LED.

Table 11. 

Function RN1_8_470 MachXO Pin

LED0 D1 T10

LED1 D2 T11

LED2 D3 N10

LED3 D4 N11

LED4 D14 R11

LED5 D15 R12

LED6 D16 P11

LED7 D17 P12

LED Bank Pin Information

MachXO2280 GSR Input Push-button: A global RESET (GSR) push-button circuit (Schematic Sheet 5 or 10) con-
nects to the dedicated pad for the MachXO2280 global RESET signal (GSRN). The push-button circuit can also be 
driven from a POWR1014A output.

MachXO2280 Sleep Input Push-button: A temporary push-button switch connects to the MachXO2280 SLEEPN 
input pin. When depressed the MachXO2280 enters Sleep Mode. Note that during sleep all I/Os of the device are 
tri-stated. The push-button circuit can also be driven from a POWR1014A output.

MachXO2280 TSALL Input Jumper: A tri-state all (TSALL) jumper circuit (Schematic Sheet 5 or 10) connects to the 
dedicated pad for the MachXO2280 global output enable signal. When TSALL is high all the outputs are tristated. 

Oscillator Circuit
A 62.5MHz oscillator circuit (Schematic Sheet 5 of 10) fans out to a primary clock input of the MachXO USB con-
troller PHY, prototype area, and GPIO Expansion Connector. You may disable the oscillator circuit by installing 
jumper J24.
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Power Manager II Mixed Signal PLD (ispPAC-POWR1014A)
The Power Manager II (ispPAC-POWR1014A-01TN48I) (U17 – Schematic Sheet 8 of 10) provides a programmable 
power supply supervisor, reset generation, and sequencing control features for the MachXO Control Evaluation 
Board. By default the POWR1014A is programmed to monitor current and voltage levels of the MachXO2280 
Icccore, Iccaux, Iccio, Vcccore, Vccaux, and Vccio using VMON inputs 1-6. 

Table 12. 

Item Description

Reference Designators U17

Part Number ispPAC-POWR1014A

Manufacturer Lattice Semiconductor Corporation

Web Site www.latticesemi.com

POWR1014A Reference

POWR1014A DIP Switch Input: The MachXO Control Evaluation Board includes a two-bit input toggle switch tied 
to digital inputs of the POWR1014A (SW4 – Schematic Sheet 8 of 10). When in the open position, the switch is 
pulled to 3.3V via a 10K resistor. When in the down position, the switch is tied to ground. 

Table 13. POWR1014A DIP Switch Pin Information

Function U17 Pin Description MachXO Pin Other Connection

POWR1014A LED Bank: The MachXO Control Evaluation Board includes four LEDs tied to digital outputs of the 
POWR1014A (Schematic Sheet 8 of 10). Driving logic low ‘0’ will light a LED.

Table 14. POWR1014A LED Bank Pin Information

Function RN2_4_470 POWR1014A Pin

PM_LED0 D5 12

PM_LED1 D6 11

PM_LED2 D7 10

PM_LED3 D8 9

Power Supplies, Supply Control, and Fault Circuits
The MachXO Control Evaluation Board features a single coaxial input connector to apply power (Schematic Sheet 
7 of 10). A 5V DC source must be applied to power the board. 

A low dropout voltage regulator converts +5V to +3.3V. Two MOSFET power switch circuits controlled by the 
POWR1014A enable the MachXO2280 Vcccore and Vccaux supplies. For more information on using power MOS-
FETs with Power Manager and Power Manager II devices see AN6048, Using Power MOSFETs with Power Man-
ager Devices.

To emulate a supply failure on the MachXO Control Evaluation Board, you may remove either unplug the power 
supply to disable the 5V input or remove Vccaux or Vccio jumpers connected to the voltage monitor inputs to the 
POWR1014A (Schematic 8 of 10). When programmed with the default PC Board Control and Power Management 
demo design the supply rail failure and time will be recorded to a diagnostic log of the on-board SPI Flash Memory.

Prototyping Area
The MachXO Control Evaluation Board provides 1” x 3”, 140-hole prototyping area with connections to 
MachXO2280 GPIOs (Schematic Sheet 8 and 9 of 10), +3.3V, and GND. The area is organized as 7 columns of 
100-mil spaced holes. 

http://www.latticesemi.com
www.latticesemi.com/dynamic/view_document.cfm?document_id=5935
www.latticesemi.com/dynamic/view_document.cfm?document_id=5935
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Table 15. Prototype Area Column Organization

Column

1 2 3 4 5 6 7

Function +3.3V Proto Area (NC) GND Proto I/Os

Table 16. Column 7 Proto I/O Pin Information

Function Proto I/O Pin MachXO2280 Pin

ProtoT4 IO12 T4

ProtoR6 IO80 R6

ProtoT6 IO34 T6

ProtoT8 IO18 T8

ProtoM7 IO35 M7

ProtoM8 IO31 M8

ProtoR7 IO76 R7

ProtoR8 IO79 R8

ProtoN8 IO83 N8

ProtoN9 IO62 N9

ProtoP9 IO63 P9

ProtoP10 IO64 P10

ProtoM10 IO82 M10

ProtoR9 IO72 R9

ProtoR10 IO73 R10

ProtoP15 IO74 P15

ProtoP16 IO75 P16

OSC_CLK IO77

XO_SDA IO78 K5

XO_SCL IO84 K4

PWM Analog Output Circuit
A pulse width modulated type circuit (Schematic Sheet 3 of 10) is provided to serve a digital to analog conversion 
(DAC). A stereo phonejack (J26) allow you to connect external speakers or headphones to the MachXO Control 
Evaluation Board.

SD Flash Memory Card Socket
A 9 pin SD card socket is provided (U23 – Schematic Sheet 3 of 10) with the ability to interface to SD card memory 
cards.

SPI Flash Memory
The board is populated with an Atmel non-volatile 2 M-bit SPI Flash memory (U69 – Schematic Sheet 3 of 10). 

Table 17. SPI Flash Memory Reference

Item Description

Reference Designators U69

Part Number M25PE20-VMN6TP

Manufacturer Numonyx/ST Micro

Web Site www.numonyx.com
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SRAM
The board is populated with 1 Mbit of SRAM from Cypress (U8 – Schematic Sheet 3 of 10) with a data bus width of 
8 bits. The 17-bit address bus, the data bus and the control signals are connected directly to the CPLD. The 17-bit 
address bus, named MEMORY_A0 through MEMORY_A16, addresses 1 byte locations. 

Table 18. SRAM Reference

Item Description

Reference Designators U8

Part Number CY128X8TSOP

Manufacturer Cypress Semiconductor

Web Site www.cypress.com

Status LEDs
One red power OK status LED is provided. 

Temperature Sensor
The temperature sensor on the MachXO Control Evaluation Board is a TI TMP101NA/250 device (U15 – Sche-
matic Sheet 3 of 10). It uses an I2C bus slave interface to provide the temperature reading on the board.

Test Points
In order to check the various voltage levels used, several test points are provided:

• VCC (1.2V, 2.5V, and 3.3V)

• VCCAUX

• VCCIO of all banks

• GND

• Clock source

• ADC GND

• ADC Vin

• DAC Vout

• DAC Fdbk

USB Programming and RS-232 Interface 
The USB programming and data interface circuit (Schematic Sheet 10 of 10) provides clocking, boot memory, a 
FTDI Chip dual USB UART/FIFO device.

By default, the MachXO Control Evaluation Board’s pre-programmed PC Board Control and Power Management 
demo design provides a user interface layer to a PC-based terminal program.

Voltage Ramp Circuit
The evaluation board includes two voltage ramp circuits (Schematic Sheet 8 of 10) tied to the high-voltage outputs 
of the POWR1014A. Vishay N-channel MOSFETs are included so test equipment can be attached to examine con-
trolled FET ramp rate. FET source pins are attached to voltage monitor inputs of the POWR1014A.

Ramp the voltage of two simulated supplies up using the HVOUT1 and HVOUT2 outputs. Each circuit will be 
ramped up at a different rate. The HVOUT outputs will each be connected to a circuit using a MOSFET controlling 
a resistor and capacitor network. The voltage output of this circuit will be monitored by the VMON7 and VMON8 
inputs. When the voltage on each of these inputs reaches the preset value, an LED on the POWR1014A LED bank 
will be lit.

http://www.cypress.com/
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Programming
Programming for the MachXO and Power Manager II devices are controlled using the ispVM® System software, 
available for download from the Lattice website at www.latticesemi.com/ispvm.

Refer to the ispVM System software for help regarding operation of this software.

The MachXO Control Evaluation Board is equipped with a built-in USB-based programming circuit. This consists of 
a USB PHY and a USB connector. When the board is connected to a PC with a USB cable, it is recognized by the 
ispVM System software as a “USB Download Cable”. The MachXO PLD can then be scanned and programmed 
using the ispVM System 17.5 or later software. 

Mechanical Specifications
Dimensions: 6 ¼ in. [L] x 4 in. [W] x 5/8 in. [H]

Environmental Requirements
The evaluation board must be stored between -40° C and 100° C. The recommended operating temperature is 
between 0° C and 55° C.

The evaluation board can be damaged without proper anti-static handling.

Modifying the MachXO Control Evaluation Board
The MachXO Control Evaluation Board provides a prototyping area to support extensions of its functionality.

Note: Modifying your board requires good electronics handling and PCB fabrication techniques to avoid damage.

This section describes how to modify the MachXO Control Evaluation Board to support the Voltage Monitoring 
Demo using internal LVDS buffers.

1. Add a two-pin header (such as Samtech TSW-102-07-G-S, or equivalent) in the prototyping area, occupying 
the ProtoP9 and the adjacent GND thru-holes.  (Schematic: sheet 9 of 10)

2. Add a 3.3k resister between ProtoP10 and ProtoM10 thru-holes.

3. Add a 820p capacitor between Proto P10 and the adjacent GND thru-holes.

In this configuration, the two-pin header is used to facilitate the connection of a bench voltage supply and ground. 
The input voltage must be limited between +3.2 volts and ground. 

Note: Exercise good electronics handling to avoid ESD damage to the MachXO device when making bench con-
nections.

Glossary
CPLD: Complex Programmable Logic Device

DIP: Dual in-line package.

I2C: Inter-Integrated Circuit.

LED: Light Emitting Diode.

PCB: Printed Circuit Board.

RoHS: Restriction of Hazardous Substances Directive.

PLL: Phase Locked Loop.

SPI: Serial Peripheral Interface.

http://www.latticesemi.com/products/designsoftware/ispvmsystem/index.cfm
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SRAM: Static Random Access Memory.

TransFR: Transparent Field Reconfiguration.

UART: Universal Asynchronous Receiver/Transmitter.

USB: Universal Serial Bus.

WDT: Watchdog timer

Troubleshooting
Board Does Not Power On Completely
If jumper is not installed at J17, when power is initially applied to the board, the POWR1014A will stop the power-on 
sequence of the board. Install a jumper at J17 to enable the power-on sequence.

Board Continuously Resets
If position 2 of the POWR1014A DIP Switch (SW4) is depressed the board will continuously cycle the reset input of 
the system. Raise position 2 of SW4 for normal operation.

Other JTAG Devices are Ignored by ispVM Software

• See Schematic Sheet 1 of 10 to ensure the TDI-TDO and TMP jumper settings enable the Other JTAG option.

• All JTAG devices attached to the MachXO Control Evaluation Board JTAG chain, must use a 3.3V supply rail to 
be recognized by ispVM System software.

Determine the Source of a Pre-Programmed Part
It’s likely you will receive your MachXO Control Evaluation Board after it has been reviewed and reprogrammed by 
someone else. To restore the board to the factory default, see the Download Demo Designs section of this docu-
ment for details on downloading and reprogramming the device.

You can also determine which demo design is currently programmed onto the board by comparing the JEDEC 
checksums against of the programming file with what is read from the programmed part.

To compare JEDEC file checksum:

1. Connect the MachXO Control Evaluation Board to a host PC using the USB ports.

2. Start ispVM and choose ispTools > Scan. The LCMXO2280C appears in the Device List.

3. Double-click the LCMXO2280C row. The Device Information dialog appears.

4. Click the Browse button. The Save as Data File dialog appears.

5. Specify a new JEDEC Data File name and click the Save button.

6. From the Operation list choose FLASH Read and Save and click OK.

7. Choose Project > Download. ispVM reads the Flash contents from the MachXO and writes the results to the 
JEDEC file specified.

Open the JEDEC file into a text editor and page to the bottom of the file. 

Note the hexidecimal checksum at the line above the User Electronic Data note line. Compare this value 
against the checksum of the original JEDEC demo programming files.
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Ordering Information

Description Ordering Part Number
China RoHS Environment-Friendly 

Use Period (EFUP)

MachXO Control Development Kit LCMXO2280C-M-EVN

Technical Support Assistance
Hotline: 1-800-LATTICE (North America)

+1-503-268-8001 (Outside North America)
e-mail: techsupport@latticesemi.com
Internet: www.latticesemi.com

Revision History
Date Version Change Summary

August 2009 01.0 Initial release.

August 2009 01.1 Added Appendix A - Schematic.

Updated Appendix B - Bill of Materials.

October 2009 01.2 Included support for the Power Supply Fault Logging, Voltage Monitor-
ing and Memory-Audio demos.

April 2010 01.3 Updated Appendix A - Schematic.

June 2010 01.4 Updated “Voltage Monitoring Demo” section.

Added “Modifying the MachXO Control Evaluation Board” section.

© 2010 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as 
listed at www.latticesemi.com/legal. All other brand or product names are trademarks or registered trademarks of 
their respective holders. The speci• cations and information herein are subject to change without notice.

http://www.latticesemi.com/
http://www.latticesemi.com/corporate/legal/index.cfm


44

 
Lattice Semiconductor MachXO Control Development Kit User’s Guide 

Appendix A. Schematic
Figure 15. Configuration
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Figure 16. MachXO Banks 0 and 1
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Figure 19. MachXO Banks 6 and 7

5 5

4 4

3 3

2 2

1 1

D
D

C
C

B
B

A
A

T
S

A
LL

O
S

C
_C

LK

O
S

C
_C

LK

+
3.

3V

+
3.

3V

+
3.

3V

+
3.

3V

+
3.

3V

+
3.

3V

+
3.

3V

F
T

_S
D

A
F

T
_S

C
L

P
M

_O
U

T
10

P
M

_O
U

T
11

P
M

_O
U

T
12

X
O

_R
E

S
E

T

O
S

C
_C

LK

X
O

_S
C

L
X

O
_S

D
A

P
M

_I
N

1
P

M
_I

N
2

P
M

_P
LD

C
LK

P
M

_M
C

LK

B
D

B
U

S
0

B
D

B
U

S
1

B
D

B
U

S
5

B
D

B
U

S
2

B
D

B
U

S
3

B
D

B
U

S
4

B
D

B
U

S
6

B
D

B
U

S
7

B
C

B
U

S
0

B
C

B
U

S
1

B
C

B
U

S
2

B
C

B
U

S
3

S
I-

W
U

B

A
C

B
U

S
2

A
C

B
U

S
3

A
C

B
U

S
0

A
C

B
U

S
1

X
O

_I
2C

_A
LE

R
T

P
M

_I
2C

_A
LE

R
T

P
M

_S
C

L
P

M
_S

D
A

D
at

e:

S
iz

e
S

ch
em

at
ic

 R
ev

of
S

he
et

T
itl

e

La
tti

ce
 S

em
ic

on
du

ct
or

 A
pp

lic
at

io
ns

E
m

ai
l: 

te
ch

su
pp

or
t@

La
tt

ic
es

em
i.c

om
P

ho
ne

 (
50

3)
 2

68
-8

00
1 

-o
r-

 (
80

0)
 L

A
T

T
IC

E

B
oa

rd
 R

ev

P
ro

je
ct

M
on

da
y,

 1
3-

A
pr

-0
9

B

10
5

M
ac

hX
O

 B
an

ks
 6

 a
nd

 7

M
ac

hX
O

 C
on

tr
ol

 B
oa

rd
B

D
at

e:

S
iz

e
S

ch
em

at
ic

 R
ev

of
S

he
et

T
itl

e

La
tti

ce
 S

em
ic

on
du

ct
or

 A
pp

lic
at

io
ns

E
m

ai
l: 

te
ch

su
pp

or
t@

La
tt

ic
es

em
i.c

om
P

ho
ne

 (
50

3)
 2

68
-8

00
1 

-o
r-

 (
80

0)
 L

A
T

T
IC

E

B
oa

rd
 R

ev

P
ro

je
ct

M
on

da
y,

 1
3-

A
pr

-0
9

B

10
5

M
ac

hX
O

 B
an

ks
 6

 a
nd

 7

M
ac

hX
O

 C
on

tr
ol

 B
oa

rd
B

D
at

e:

S
iz

e
S

ch
em

at
ic

 R
ev

of
S

he
et

T
itl

e

La
tti

ce
 S

em
ic

on
du

ct
or

 A
pp

lic
at

io
ns

E
m

ai
l: 

te
ch

su
pp

or
t@

La
tt

ic
es

em
i.c

om
P

ho
ne

 (
50

3)
 2

68
-8

00
1 

-o
r-

 (
80

0)
 L

A
T

T
IC

E

B
oa

rd
 R

ev

P
ro

je
ct

M
on

da
y,

 1
3-

A
pr

-0
9

B

10
5

M
ac

hX
O

 B
an

ks
 6

 a
nd

 7

M
ac

hX
O

 C
on

tr
ol

 B
oa

rd
B

S
h
e
e
t
 
8

P
o
w
e
r
 
M
a
n
a
g
e
r

O
sc

ill
at

or
 6

2.
5M

H
z

U
S
B
 
D
a
t
a

S
h
e
e
t
 
1
0

U
S
B
 
D
a
t
a

S
h
e
e
t
 
1
0

R
12

3

2_
2K

D
I

R
12

3

2_
2K

D
I

C
98

0_
1u

F
D

I

C
98

0_
1u

F
D

I

R
13

4

10
K

D
I

R
13

4

10
K

D
I

S
1

X
O

 G
lo

ba
l R

es
et

D
IS

1

X
O

 G
lo

ba
l R

es
et

D
I

1
4

2
3

R
62

10
k

D
I

R
62

10
k

D
I

R
58 10

k D
I

R
58 10

k D
I

C
64

0_
1u

F
D

IC
64

0_
1u

F
D

IR
56

10
k

D
I

R
56

10
k

D
I

R
12

5

2_
2K

D
I

R
12

5

2_
2K

D
I

R
13

5

10
K

D
I

R
13

5

10
K

D
I

R
63

10
k

D
I

R
63

10
k

D
I

R
59

10
k

D
I

R
59

10
k

D
I

R
57

10
k

D
I

R
57

10
k

D
I

R163 10K
DI

R163 10K
DI

J6 Ju
m

pe
r_

1w
ay

D
I

J6 Ju
m

pe
r_

1w
ay

D
I

1 2

L5 F
er

rit
e_

be
ad

B
D

06
03

D
I

L5 F
er

rit
e_

be
ad

B
D

06
03

D
I

6
OI

C
C

V
7

OI
C

C
V

P
i
n
 
n
a
m
e
 
s
e
q
u
e
n
c
e

P
L
(
6
4
0
,
1
2
0
0
,
2
2
8
0
)

U
60

B
LC

M
X

O
64

0/
12

00
/2

28
0-

F
T

25
6/

F
T

N
25

6

6
OI

C
C

V
7

OI
C

C
V

P
i
n
 
n
a
m
e
 
s
e
q
u
e
n
c
e

P
L
(
6
4
0
,
1
2
0
0
,
2
2
8
0
)

U
60

B
LC

M
X

O
64

0/
12

00
/2

28
0-

F
T

25
6/

F
T

N
25

6

N
C

/P
L2

A
/P

L2
A

/P
LL

1T
_F

B
E

4

N
C

/P
L2

B
/P

L2
B

/P
LL

1C
_F

B
E

5

N
C

/P
L3

A
/P

L3
A

/L
V

_T
F

5

N
C

/P
L3

B
/P

L3
B

/L
V

_C
F

6

P
L3

A
/P

L3
C

/P
L3

C
/P

LL
1T

_I
N

F
3

P
L3

B
/P

L3
D

/P
L3

D
/P

LL
1C

_I
N

F
4

P
L2

C
/P

L4
A

/P
L4

A
/L

V
_T

E
3

P
L2

D
/P

L4
B

/P
L4

B
/L

V
_C

E
2

N
C

/P
L4

C
/P

L4
C

C
3

N
C

/P
L4

D
/P

L4
D

C
2

P
L2

A
/P

L5
A

/P
L5

A
/L

V
_T

B
1

P
L2

B
/P

L5
B

/P
L5

B
/L

V
_C

C
1

P
L3

C
/P

L5
C

/P
L6

C
D

2

P
L3

D
/P

L5
D

/P
L6

D
D

1

P
L5

A
/P

L6
A

/P
L7

A
/L

V
_T

F
2

P
L5

B
/P

L6
B

/P
L7

B
/G

S
R

/L
V

_C
G

2

P
L4

A
/P

L6
C

/P
L7

C
E

1

P
L4

B
/P

L6
D

/P
L7

D
F

1

N
C

/P
L7

A
/P

L8
A

/L
V

_T
G

4

N
C

/P
L7

B
/P

L8
B

/L
V

_C
G

5

P
L4

C
/P

L7
C

/P
L8

C
G

3

P
L4

D
/P

L7
D

/P
L8

D
H

3

N
C

/P
L8

A
/P

L9
A

/L
V

_T
H

4

N
C

/P
L8

B
/P

L9
B

/L
V

_C
H

5

P
L5

C
/P

L8
C

/P
L1

0C
G

1

P
L5

D
/P

L8
D

/P
L1

0D
H

1

P
L6

A
/P

L9
A

/P
L1

1A
/L

V
_T

H
2

P
L6

B
/P

L9
B

/P
L1

1B
/L

V
_C

J2

P
L7

C
/P

L9
C

/P
L1

1C
J3

P
L7

D
/P

L9
D

/P
L1

1D
K

3

P
L6

C
/P

L1
0A

/P
L1

2A
/L

V
_T

J1

P
L6

D
/P

L1
0B

/P
L1

2B
/L

V
_C

K
1

P
L9

A
/P

L1
0C

/P
L1

2C
K

2

P
L9

B
/P

L1
0D

/P
L1

2D
L2

P
L7

A
/P

L1
1A

/P
L1

3A
/L

V
_T

L1

T
S

A
LL

/P
L8

C
/P

L1
1C

/P
L1

4C
N

1

P
L8

D
/P

L1
1D

/P
L1

4D
P

1

P
L1

0A
/P

L1
2A

/P
L1

5A
/L

V
_T

L3

P
L1

0B
/P

L1
2B

/P
L1

5B
/L

V
_C

M
3

P
L9

C
/P

L1
2C

/P
L1

5C
M

2

P
L9

D
/P

L1
2D

/P
L1

5D
N

2

P
L8

A
/P

L1
3A

/P
L1

6A
/L

V
_T

J4

P
L8

B
/P

L1
3B

/P
L1

6B
/L

V
_C

J5

P
L1

1A
/P

L1
3C

/P
L1

6C
R

1

P
L1

1B
/P

L1
3D

/P
L1

6D
R

2

N
C

/P
L1

4A
/P

L1
7A

/L
V

_T
/P

LL
0_

T
_F

B
K

5

N
C

/P
L1

4B
/P

L1
7B

/L
V

_C
/P

LL
0_

C
_F

B
K

4

P
L1

0C
/P

L1
4C

/P
L1

7C
L5

P
L1

0D
/P

L1
4D

/P
L1

7D
L4

N
C

/P
L1

5A
/P

L1
8A

/L
V

_T
/P

LL
0_

T
_I

N
M

5

N
C

/P
L1

5B
/P

L1
8B

/L
V

_C
/P

LL
0_

C
_I

N
M

4

P
L1

1C
/P

L1
6A

/P
L1

9A
N

4

P
L1

1D
/P

L1
6B

/P
L1

9B
N

3

P
L7

B
/P

L1
1B

/P
L1

3B
/L

V
_C

M
1

U
38

D
I

U
38

D
I

V
C

C
4

T
ris

ta
te

1

O
U

T
P

3

G
N

D

2

C
83

0_
01

uF
D

I

C
83

0_
01

uF
D

I
J2

4

H
D

1X
2

D
I

J2
4

H
D

1X
2

D
I

12

S
he

et
 8

 I2 C
 B

us
 A

le
rt

S
he

et
 3

 I2 C
 B

us
 A

le
rt

S
he

et
 5

 I2 C
 F

T-
X

O
 B

us

S
he

et
 8

 I2 C
 B

us

S
he

et
s 

3,
 4

, 5
, 9

 I2 C
 B

us

S
he

et
s 

2,
 8

, 9

S
he

et
 X



49

 
Lattice Semiconductor MachXO Control Development Kit User’s Guide 

Figure 20. MachXO Power
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Figure 21. Board Power
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Figure 22. Power Manager II
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Figure 23. Prototype Area
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Figure 24. USB Program Data
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Appendix B. Bill of Materials
Table 19. Bill of Materials 
Item Quantity Reference Part Footprint Populate Vendor Part Number Description

1 2 C48, C52 12pF SM/C_0603 DI Murata Electronics ERB1885C2E120JDX5D 12pF surface mount cap

2 38

C6, C7, C8, C12, C13, C14, 
C15, C16, C17, C18, C22, 
C23, C24, C25, C29, C30, 
C31, C33, C34, C36, C37, 
C38, C39, C40, C41, C42, 
C43, C44, C46, C47, C50, 
C64, C69, C70, C71, C72, 
C73, C98

0_1uF SM/C_0603 DI Panasonic ECJ-1VB1C104K 0.1uF surface mount cap

3 1 C51 0_1uF SM/C_0603 DNI Panasonic ECJ-1VB1C104K 0.1uF surface mount cap

4 3 C19, C21, C35 10uF SM/C_0603 DI TDK Corp. C1608Y5V0J106Z 10uF surface mount cap

5 1 C20 22uF SM/C_0805 DI Taiyo Yuden LMK212BJ226MG-T 22uF surface mount cap

6 7 C45, C54, C55, C65, C66, 
C67, C83 0_01uF SM/C_0603 DI Murata Electronics GRM188R71H103KA01D 0_01 SMC

7 2 C53, C58 33pF SM/C_0603 DI Panasonic ECJ-1VC2A330J 33pF SMC

8 13 D1, D2, D3, D4, D5, D6, D7, 
D8, D14, D15, D16, D17, D18 LED SM/D_0603 DI Lite-On LTST-C190CKT LEDRED

9 1 D19 D_SW SM/SOD_323 DI Diodes 1N4148WS SM-SOD-323

10 1 J8 USB_MINI_B TYPE_B DI Hirose UX60-MB-5ST USBType-BMiniConnector

11 7 J5, J6, J9, J14, J15, J18, J19 Jumper_1way BLKCON.100/VH/
TM1SQ/W.100/2 DI Samtec Inc. TSW-102-07-G-S Jumper with Shunt 

(929957-08)

12 1 J23 Jumper_2way JP_2WY DI Samtec Inc. TSW-103-07-G-S Jumper with Shunt 
(929957-08)

13 1 J10 PWR_JACK PWR_CON DI Switchcraft RAPC712 CoaxialDCconnector

14 3 J17, J22, J24 HD1X2 BLKCON.100/VH/
TM1SQ/W.100/2 DI Samtec Inc. TSW-102-07-G-S Jumper with Shunt 

(929957-08)

15 1 J13 HD9x2 HD9x2 DI Samtec Inc. TSW-109-07-G-D Jumper with Shunt 
(929957-08)

16 1 J16 CF_ Socket CF_2X30 DI AVX AVX-31-5620-050-116-871 AVXCFconnector

17 1 L5 Ferrite_bead BD0603 DI Steward MI0603J600R-00 SMD0603 Ferrite Bead

18 1 Q3 2N2369A SM/SOT23 DI Fairchild 
Semiconductor MMBT2369A Transistor NPN SOT-23

19 1 RN1 RN1_8_470 SMD_0603 DI Rohm 
Semiconductor MNR18E0APJ471 SMD_0602

20 1 RN2 RN1_8_10K SMD_0603 DI Rohm 
Semiconductor MNR18E0APJ103 SMD_0602

21 2 R6, R39 330 SM/R_0603 DI Panasonic ECG ERJ-3EKF3300V RES 330 OHM 1/10W 
1% 0603 SMD

22 4 R15, R195, R196, R197 0 SM/R_0603 DI Panasonic ECG ERJ-3GEY0R00V Resistor 0.0 SMD 0603

23 9 R40, R41, R43, R44, R45, 
R47, R48, R50, R182 100 SM/R_0603 DI Vishay/Dale CRCW0603100RFKEA SMT resistor

24 7 R54, R189, R190, R201, 
R202, R204, R205 1k SM/R_0603 DI Vishay/Dale CRCW06031K00FKEA Resistor 1k SMD 0603

25 3 R10, R123, R125 2_2K SM/R_0603 DI Panasonic ECG ERJ-3GEYJ222V Resistor 2.2k SMD 0603

26 30

R26, R32, R36, R38, R56, 
R57, R58, R59, R62, R63, 
R81, R82, R126, R127, 
R129, R130, R132, R133, 
R134, R135, R159, R163, 
R179, R183, R184, R188, 
R191, R192, R193, R194

10K SM/R_0603 DI Vishay/Dale CRCW060310K0FKEA 10K 0603 SMT resistor

27 46

R65, R66, R67, R68, R69, 
R73, R76, R103, R104, 
R105, R107, R110, R111, 
R114, R116, R118, R124, 
R128, R131, R148, R149, 
R151, R152, R153, R154, 
R155, R156, R157, R161, 
R162, R165, R166, R167, 
R168, R169, R170, R171, 
R172, R173, R174, R175, 
R176, R177, R178, R181, 
R185

10k SM/R_0603 DNI Vishay/Dale CRCW060310K0FKEA 10K 0603 SMT resistor

28 1 R27 3k SM/R_0603 DI Panasonic ECG ERJ-3EKF3001V RES 3.00K OHM 1/10W 
1% 0603 SMD

29 1 R83 5_1k SM/R_0603 DI Panasonic ECG ERJ-3EKF5101V SMD 0603

30 1 R158 4_7k SM/R_0603 DI Panasonic ECG ERJ-3EKF4701V RES 4.7K OHM 1/10W 
1% 0603 SMD

31 1 SW2 SW DIP-8 CTS 208-8 DI CTS Corporation 
Electrocomponents 194-8MST x8 DIP Switch Piano

32 1 S1 XO Global Reset SMT_SW DI Panasonic ECG EVQ-Q2K03W SPST_Switch
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33 1 U8 CY128X8TSOP 32-TSOP DI Cypress CY7C1019DV33-10ZSXI IC SRAM 128KX8 
ASYNC 32-TSOP

34 1 U70 M93C46-WMN6TP SOIC-8 DI STMicroelectronics M93C46-WMN6TP IC 1K EEPROM 8-SOIC

35 1 U15 TMP101 SM/SOT23_6 DI TI TMP101NA/250 IC TEMP SENSOR 
DIG SOT-23-6

36 1 U23 SD Socket SM/SD DI 3M SD-RSMT-2-MQ-WF SD socket

37 1 U32 MOSFET SOT-223-4 DI Fair Child NDT3055LCT-ND MOSFET N-CH

38 1 U34 Fan 3 Pin Connector SP-10 DI Molex/Waldom 
Electronics WM4201-ND Molex Connector Corp.

39 1 U35 Fan Fan DI Fantronic
EC2510M05CA,NY PMS 440 
0063 PH,NUT HEX 4-40 
NYLON

Evercool 25x10mm Fan 
& two mouting nylon 
nuts/bolts

40 1 U42 QS3861 TSSOP_24 DI IDT IDTQS3861PAG8 TSSOP-24

41 1 J26 PHONEJACK STEREO SM DI CUI SJ1-3513-SMT 3.5mm_AudioJack

42 1 R11 470 SM/R_0603 DI Panasonic ECG ERJ-3EKF4700V RES470OHM1/10W1%

43 2 R12, R13 27 SM/R_0603 DI Panasonic ECG ERJ-3GEYJ270V Resistor 27 SMD 0603

44 1 R14 100k SM/R_0603 DI Panasonic ECG ERJ-3GEYJ104V Resistor 100k SMD 0603

45 1 R53 1M SM/R_0603 DI Panasonic ECG ERJ-3GEYJ105V RES 1.0M1/10W5%

46 1 SW3 XO_Sleep_SW SMT_SW DI Panasonic ECG EVQ-Q2K03W SPST_Switch

47 1 U7 NCP1117 SOT-223 DI ON Semiconductor NCP1117ST33T3G Voltage Regulators - 
Linear

48 1 U16 LMV331 SOT-23-5 DI TI LMV331IDBVR Comparators

49 1 X3 6 MHz SMD DI Citizen 
America Corp. HCM49 6.000MABJ-UT CRYSTAL 6.000 MHz 

SMT 18PF

50 1 R37 1_5k SM/R_0603 DI Panasonic ECG ERJ-3GEYJ152V Resistor 1.5k SMD 0603

51 1 U4 FT2232 TQFP_48 DI Future FT2232D R USB UART/FIFO

52 1 U44 POT 8-µSOP DI Dallas 
Semiconductor DS3904U-020+ Variable POT

53 2 C79, C80 1uF SM/C_0805 DI Panasonic ECG ECJ-2YB1A105K 1uF SMC

54 2 J4, J7 CON40A 2x20x100mil DNI Samtec Inc. TSW-120-07-G-D Header

55 2 Q5, Q6 2N7002E SM/SOT23 DI ON Semiconductor 2N7002ET1G MOSFET N-CH SGL
60V 310A SOT-23

56 1 Q7 ZDT758 SM-8 DUAL PNP DI zetex ZDT758 SM-8 DUAL PNP

57 1 RN3 RN2_4_470 SMD_0603 DI Yageo TC164-JR-07470RL RES ARRAY 470 OHM

58 2 R186, R187 200 SM/R_0603 DI Panasonic ECG ERJ-3GEYJ201V RES 200 OHM 1/10W 
5% 0603 SMD

59 2 R200, R203 220 SM/R_0603 DI Panasonic ECG ERJ-3EKF2200V RES 220 OHM 1/10W 
1% 0603 SMD

60 1 SW4 SW DIP-2 SP-75 DI CTS 195-2MST SWITCH SIDE 
ACTUATED 2 SEC

61 1 U38 Oscillator_62_5 SMD DI Fox Electronics FXO-HC735-62.5 MHz OSC 62.5 MHZ 
3.3V SMD

62 1 U17 ispPAC-POWR1014A 48 TQFP DI Lattice POW1014A Power Manager

63 1 U60 LCMXO640/1200/
2280-FT256/FTN256 256 ftBGA DI Lattice MachXO_2280 MachXO

64 1 U67 STG3690QTR QFN DI STMicroelectronics STG3690QTR Dual Switch

65 1 U68 AD8604ARZ 14 SOIC DI Analog Devices 
Inc. AD8604ARZ Quad OP AMP SOIC

66 1 U69 M25PE20-VMN6TP 8 SOIC DI Numonyx/
ST Micro M25PE20-VMN6TP IC SPI Flash 

2MBit 8-SOIC

67 1 R5 1 SM/R_0805 DI Vishay Dale CRCW08051R00FKEA Resistor 1 1%

68 2 R3, R7 2 SM/R_0805 DI Rohm 
Semiconductor MCR10EZHFL2R00 Resistor 2 1% 

1/4W

69 8 MH5, MH6, MH7, MH8, MH9, 
MH10, MH11, MH12 M_HOLE1 IW_MNT0 DI 3M SJ-5003 (BLACK) BUMPON HEMISPHERE 

.44X.20 BLACK

70 4 R30, R31, R46, R49 3_92k SM/R_0603 DI Susumu Co. Ltd. RG1608P-3921-B-T5 RES 3.92K OHM 1/10W 
.1% 0603 SMD

71 2 R29, R42 2k SM/R_0603 DI Susumu Co. Ltd. RG1608P-202-B-T5 RES 2.0K OHM 1/10W 
.1% 0603 SMD

Table 19. Bill of Materials (Continued)
Item Quantity Reference Part Footprint Populate Vendor Part Number Description
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72 205

DB1, CB1, BB1, DB2, CB2, 
BB2, DB3, CB3, BB3, DB4, 
CB4, BB4, DB5, CB5, BB5, 
GND_6, DB6, CB6, BB6, 
IO7, GND_7, DB7, CB7, 
BB7, IO8, DB8, CB8, BB8, 
IO9, DB9, CB9, BB9, 
GND_10, DB10, CB10, 
BB10, IO11, GND_11, DB11, 
CB11, BB11, IO12, DB12, 
CB12, BB12, IO13, DB13, 
CB13, BB13, IO14, DB14, 
CB14, BB14, AB14, IO15, 
DB15, CB15, BB15, DB16, 
CB16, BB16, AB16, IO17, 
DB17, CB17, BB17, IO18, 
DB18, CB18, BB18, AB18, 
IO19, DB19, CB19, BB19, 
IO20, DB20, CB20, BB20, 
AB20, IO21, IO22, AB22, 
IO23, IO24, AB24, IO25, 
IO26, AB26, IO28, AB28, 
GND_29, IO30, GND_30, 
AB30, IO31, GND_32, AB32, 
IO33, GND_33, IO34, AB34, 
IO35, IO36, AB36, AB38, 
AB40, AB42, AB44, AB46, 
AB48, IO50, GND_50, AB50, 
GND_51, IO52, AB52, IO53, 
GND_53, IO54, GND_54, 
IO55, GND_55, IO56, 
GND_56, IO57, GND_57, 
IO59, GND_59, IO60, 
GND_60, IO61, GND_61, 
AB61, IO62, GND_62, AB62, 
IO63, AB63, IO64, AB64, 
IO65, GND_65, AB65, IO66, 
GND_66, AB66, IO67, 
GND_67, AB67, IO68, 
GND_68, AB68, IO69, 
GND_69, AB69, IO70, 
GND_70, AB70, IO71, 
GND_71, AB71, IO72, 
GND_72, AB72, IO73, AB73, 
IO74, AB74, IO75, AB75, 
IO76, AB76, IO77, AB77, 
IO78, AB78, IO79, AB79, 
IO80, AB80, AB81, IO82, 
AB82, IO83, AB83, IO84, 
AB84, IO85, AB85, AB86, 
AB87, AB88, AB89, AB90, 
AB91, AB92, AB93, AB94, 
AB95, AB96, AB97, AB98, 
AB99, AB100

T POINT R TP

73 1 G1 Lattice Logo LOGO300_1000

74 1 G2 WEEE WEEE_SM

75 1 G3 E-Friendly EFRIENDLY_400_SM

Table 19. Bill of Materials (Continued)
Item Quantity Reference Part Footprint Populate Vendor Part Number Description
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Appendix C. Control SoC Demo I/O Plan
LOCATE COMP "led_0" SITE "T10" ;
LOCATE COMP "led_1" SITE "T11" ;
LOCATE COMP "led_2" SITE "N10" ;
LOCATE COMP "led_3" SITE "N11" ;
LOCATE COMP "led_4" SITE "R11" ;
LOCATE COMP "led_5" SITE "R12" ;
LOCATE COMP "led_6" SITE "P11" ;
LOCATE COMP "led_7" SITE "P12" ;
LOCATE COMP "rst_n" SITE "G2" ;
LOCATE COMP "scl" SITE "K4" ;
LOCATE COMP "sda" SITE "K5" ;
LOCATE COMP "spi_csn" SITE "F13" ;
LOCATE COMP "spi_miso" SITE "F14" ;
LOCATE COMP "spi_mosi" SITE "E14" ;
LOCATE COMP "spi_sclk" SITE "F12" ;
LOCATE COMP "sram_addr_0" SITE "J13" ;
LOCATE COMP "sram_addr_1" SITE "K13" ;
LOCATE COMP "sram_addr_2" SITE "K16" ;
LOCATE COMP "sram_addr_3" SITE "L16" ;
LOCATE COMP "sram_addr_4" SITE "L15" ;
LOCATE COMP "sram_addr_5" SITE "M15" ;
LOCATE COMP "sram_addr_6" SITE "M16" ;
LOCATE COMP "sram_addr_7" SITE "N16" ;
LOCATE COMP "sram_addr_8" SITE "L14" ;
LOCATE COMP "sram_addr_9" SITE "M14" ;
LOCATE COMP "sram_addr_10" SITE "L12" ;
LOCATE COMP "sram_addr_11" SITE "L13" ;
LOCATE COMP "sram_addr_12" SITE "N15" ;
LOCATE COMP "sram_addr_13" SITE "N14" ;
LOCATE COMP "sram_addr_14" SITE "M12" ;
LOCATE COMP "sram_addr_15" SITE "M13" ;
LOCATE COMP "sram_addr_16" SITE "N13" ;
LOCATE COMP "sram_data_0" SITE "H16" ;
LOCATE COMP "sram_data_1" SITE "J16" ;
LOCATE COMP "sram_data_2" SITE "J12" ;
LOCATE COMP "sram_data_3" SITE "K12" ;
LOCATE COMP "sram_data_4" SITE "J15" ;
LOCATE COMP "sram_data_5" SITE "K15" ;
LOCATE COMP "sram_data_6" SITE "J14" ;
LOCATE COMP "sram_data_7" SITE "K14" ;
LOCATE COMP "sram_cen" SITE "D14" ;
LOCATE COMP "sram_oen" SITE "D13" ;
LOCATE COMP "sram_wen" SITE "E13" ;
LOCATE COMP "sw_7" SITE "R16" ;
LOCATE COMP "sw_6" SITE "R15" ;
LOCATE COMP "sw_5" SITE "T15" ;
LOCATE COMP "sw_4" SITE "T14" ;
LOCATE COMP "sw_3" SITE "R14" ;
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LOCATE COMP "sw_2" SITE "R13" ;
LOCATE COMP "sw_1" SITE "T12" ;
LOCATE COMP "sw_0" SITE "T13" ;
LOCATE COMP "uart_rx" SITE "F5" ;
LOCATE COMP "uart_tx" SITE "F6" ;
LOCATE COMP "clk" SITE "D7" ;
LOCATE COMP "fan_en" SITE "G14" ;
LOCATE COMP "fan_sense" SITE "H14" ;
LOCATE COMP "lcd_e" SITE "R4" ;
LOCATE COMP "lcd_rs" SITE "T3" ;
LOCATE COMP "lcd_rw" SITE "P2" ;
LOCATE COMP "lcd_db_0" SITE "P3" ;
LOCATE COMP "lcd_db_1" SITE "R5" ;
LOCATE COMP "lcd_db_2" SITE "N5" ;
LOCATE COMP "lcd_db_3" SITE "P5" ;
LOCATE COMP "lcd_db_4" SITE "N6" ;
LOCATE COMP "lcd_db_5" SITE "P6" ;
LOCATE COMP "lcd_db_6" SITE "T2" ;
LOCATE COMP "lcd_db_7" SITE "T5" ;
LOCATE COMP "scl_pm" SITE "N4" ;
LOCATE COMP "sda_pm" SITE "M4" ;



 

 

 

Мы молодая и активно развивающаяся компания в области  поставок 

электронных компонентов. Мы поставляем  электронные  компоненты  

отечественного и импортного производства напрямую от производителей и с 

крупнейших складов мира. 

Благодаря сотрудничеству с мировыми поставщиками мы осуществляем 

комплексные и плановые поставки   широчайшего   спектра электронных 

компонентов. 

Собственная  эффективная  логистика и склад в обеспечивает надежную 

поставку продукции в точно указанные сроки по всей России. 

Мы осуществляем  техническую поддержку нашим клиентам и 

предпродажную проверку качества продукции. На  все поставляемые продукты 

мы предоставляем  гарантию . 

Осуществляем поставки продукции под контролем ВП МО РФ на 

предприятия военно-промышленного комплекса  России , а также работаем в 

рамках 275 ФЗ с открытием отдельных счетов в уполномоченном банке. Система 

менеджмента качества компании соответствует требованиям ГОСТ ISO 9001.  

Минимальные сроки поставки, гибкие цены, неограниченный 

ассортимент  и индивидуальный подход к клиентам являются основой для 

выстраивания долгосрочного и эффективного сотрудничества с предприятиями 

радиоэлектронной промышленности, предприятиями  ВПК и научно-

исследовательскими  институтами России. 

С нами вы становитесь  еще успешнее! 

 

 

 

 

 

Наши контакты: 

Телефон: +7 812 627 14 35 

Электронная почта: sales@st-electron.ru 

Адрес: 198099, Санкт-Петербург,  

Промышленная ул, дом № 19, литера Н,  

помещение 100-Н Офис 331 

mailto:sales@st-electron.ru

